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About this Talk

® |earn about Sysinternals tools and techniques for analyzing
and cleaning malware

® Professional antimalware analysis requires
® But even for professionals, Sysinternals tools can prove useful

® Analyzing:
® Understanding the impact of malware
® Can be used to understand malware operation
® Generates road map for cleaning infestations

® Cleaning:
® Removing an infestation of a compromised system

® Attempting a clean can also reveal more information about

malware’s operation Copyright © 2011 Mark Russinovich



Malware Cleaning Steps

® Disconnect from network

® Identify malicious processes and drivers

® Suspend and terminate identified processes
® Identify and delete malware autostarts

® Delete malware files

® Reboot and repeat
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[dentifying Malware
Processes
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What Are You Looking For?

Investigate processes that...

...have no icon
...have no description or company hame
..unsigned Microsoft images
...live in Windows directory or user profile
...are packed

...Include strange URLs in their strings
...have open TCP/IP endpoints

...host suspicious DLLs or services
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What About Task Manager?

® Task Manager provides little information about images that
are running

“EE Windows Task Manager
File Options View Help
Applications | Proc Servic Performance
Image r'-J.;rnE User Mame CFU Memory ...

ERPMT.EXE... markruss 010 15

LISE

markru = = Explorer

markruss

'STEM L / Ft W search Inde. ..

zical Memorny: 50
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Process Explorer

® Process Explorer is “Super Task Manager”

® Has lots of general troubleshooting capabilities:
® DLL versioning problems
® Handle leaks and locked files
® Performance troubleshooting
® Hung processes

® We're going to focus on its malware cleaning capabilities
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Process Explorer 2010 Updates

® \ersions 12 and 14 included many enhancements, big and small:

® Network and disk
activity Process

Multi-tab system S Elsysen
information

Tree CPU usage

Improved DLL scanning algorithm
Command-lines in process tooltips
Svchost information

Service threads

NET assembly information
Support for > 64

#_'| System |dle Process

] Tree CPU Usage CPU
6462 6462

0.21 0.23

054 054

<001 <0.01
018 0.18

26.03
25.98
0.21

B | RTSHookInterop exe
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More precise CPU accounting

® Task Manager, Resource Monitor and older Process Explorer
versions use time-slice accounting

® Whatever thread is executing at a timer tick (typically 15.6ms) is
charged for the entire time slice

® Charge is kernel mode if thread is in kernel mode, user mode for
user mode

® Process Explorer v14.1 uses cycle counts
® Full cycle count usage on Win7/Server 2008 R2 because of new API
® On Vista uses cycle counts to detect < time slice
® On XP uses context switches to detect < time slice

® Sub 0.01 usage is shown as < 0.01
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Process Explorer v15: GPU Monitoring

® Captures GPU utilization and memory usage
® System-wide |
® Per-Process

LY System Information

Summary | CPU | Memory | IjO GPU
GPU Usage

|

|

|

! GPU Dedicated Memary
|

i

||

Frocess GPU GPU Shar... GPUPnva... GPU Com.. *

—lexplore exe 2713 14,088 K 62,100 K 67,932 K
cmd.exe
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The Process View

® The process tree sort shows parent-child relationships

® Icon, description, and company name are pulled from
Image version information

® Most malware doesn’t have version information

® What about malware pretending to be from Microsoft?
® We'll deal with that shortly...

® Use the Window Finder (in the toolbar) to associate a
window with its owning process

® Use the Search Online menu entry to lookup unknown

Processes

® But malware often uses totally random or pseudo-random names
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Refresh Highlighting

® Refresh highlighting highlights changes
® Red: process exited
® Green: new process

® Change duration (default 1 second) in Options
® Press space bar to pause and F5 to refresh

® Cause display to scroll to make new processes visible with
Show New Processes option

® We'll see how to spot short-lived processes later...
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Process-type Highlights

® Blue processes are running in the same security context as
Process Explorer

® Pink processes host Windows services (we'll look at services
shortly)

® Purple highlighting indicates an image is “"packed”
® Packed can mean compressed or encrypted

® Malware commonly uses packing (e.g. UPX) to make antivirus
signature matching more difficult

® Packing and encryption also hides strings from view

® There are a few other colors, but they're not important for

malware hunting
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Tooltips

® Process tooltips show the full path to the process image

® Malware more often hides behind Svchost, Rundll32 and
DIlhost

® Tooltip for Rundll32 processes shows hosted DLL
® Dllhost tooltip shows hosted COM server

® Tooltip for service processes shows hosted services
® Services covered in detail shortly...
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Detailed Process Information

I _'1- POWERPMNT.EXE: 2556 Properties

® Double-click on a process to
see detailed information

® Image tab:

® Description, company name,
version (from .EXE)

® Full image path

® Command line used to start s xorer exe(3396)
p ro C e S S E_i::rrt:e d: :-T;E :II;I:-III:I'E;'-F'IHUIT:' 12/2009  Image: 32-bi

Comment:

® Current directory
® Parent process

® User name

@ Start time

Data Execution Protection (DEF) Status: DEP

Address Space Load Randomization: Enabled
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Windows Services

® Services can start when the system boots and run
iIndependently of the logged-on user

® Examples include IIS, Themes, Server, Workstation, ...

® Can run as their own process or as a service DLL inside a
Svchost.exe

® The services tab shows detailed service information:
® Registry name (HKLM\System\CurrentControlSet\Services\...)
Display name
Description (optional)
DLL path (for Svchost DLLs)
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Image Verification

@ All (well, most) Microsoft code is digitally signed
® Hash of file is signed with Microsoft's private key
. Eignature Is checked by decrypting signed hash with the public
ey
® You can selectively check for signatures with the Verify
button on the process image tab
® Select the Verify Image Signatures option to check all
® Add the Verified Signer column to see all

® Note that verification will connect to the Internet to check
Certificate Revocation List (CRL) servers
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Sigcheck and ListDlls

® Scan the system for suspicious executable images
sigcheck -e -u -s c:\

® ook for same characteristics as suspicious processes
® Be especially wary of items in the \Windows directory
® Investigate all unsigned images

® ListDlls will scan running processes for unisigned DLLs

listdlls -u
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Strings

® On-disk and in-memory process strings are visible on the

Strings tab
® There's only a difference if the image is compressed or encrypted

® Strings can help provide clues about unknown processes
® Look for URLs, names and debug strings

® You can also dump strings with the command-line Strings
utility from Sysinternals

strings <file>
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The DLL View

® Malware can hide as a DLL inside a legitimate process
® We've already seen this with Rundll32 and Svchost
® Typically loads via an autostart
® Can load through “dll injection”
® Packing highlight shows in DLL view as well
® Open the DLL view by clicking on the DLL icon in the
toolbar
® Shows more than just loaded DLLs
® Includes .EXE and any “memory mapped files”

® Can search for a DLL with the Find dialog

® DLL strings are also viewable from the DLL menu
Copyright © 2011 Mark Russinovich



Loaded Drivers

® There are several tools for viewing configured drivers:
® Start->Run->Msinfo32
® Builtin SC command: sc query type= driver
® Device Manager with View->Show Hidden Devices
® Process Explorer DLL view for the System process shows
loaded drivers
® Even drivers that delete their image files
® Same path and version info as standard DLL view

® Usually they're not stoppable
® Delete their files and autostart settings later

Copyright © 2011 Mark Russinovich



Terminating Malicious Processes

® Don't kill the processes
® Malware processes are often restarted by watchdogs

® Instead, suspend them
® Note that this might cause a system hang for Svchost processes
® Record the full path to each malicious EXE and DLL

® After they are all asleep then kill them
® \Watch for restarts with new names...

Copyright © 2011 Mark Russinovich



Cleaning Autostarts
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Investigating Autostarts

® Windows XP Msconfig (Start->Run->Msconfig) falls short
when it comes to identifying autostarting applications

® It knows about few locations
® [t provides little information

Unknown ME HECLUASOFTWAREN,. ..
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Autoruns

® Shows standard system extension points
® Standard Run keys and Startup folders

Shell, userinit

Services and drivers

IEN'S

Winlogon notifications

Explorer and IE addins (toolbars, Browser Helper Objects, ...)
® More and ever growing...

® Each startup category has its own tab and all items display
on the Everything tab

@ Startup name, image description, company and path
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How Autoruns Works

® Many different formats and rules for extension points
® Shared scan routine for common types

® Disabling moves an entry to a subkey or folder named
AutorunsDisabled

orites  Help

ol RenameFiles ~ || Mame Type Data
. 4. Run

ab| (Default) REG 57 (value not set)

AutorunsDisabled : P :
ab|iTunesHelper REG_5Z "C:\Program Files (

OpticnalComponents
FunOnce
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I[dentifying Malware Autostarts

® Zoom-in on add-ons (including malware) by selecting these
options:
® Verify Code Signatures
® Hide Microsoft Entries

® Select an item to see more in the lower window
® Online search unknown images

® Double-click on an item to look at where its configured in the Registry or
file system

® Has other features:
® Can display other profiles
® (Can also show empty locations (informational only)
® Includes compare functionality
® Includes equivalent command-line version, Autorunsc.exe
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Analyzing Offline Systems

@® Autoruns includes support for scanning offline systems

T Autoruns [NTDEV\markruss] - Sysinternals: www.sysinternals.com
File Entry Options User Help

= BEN::) "

5 Applnit % KnownDLLs £ winlogon h"' Wingock H

&} Everything _"E: Logon -tl Ewplorer & Intemet Explorer

Altorun Entry

Cffline System
ﬂ Select the Windows directory of the offline system:
System Root:  e:windows

&

User Profile:  e:usersiabby

.
A

= NyCplDasmon MDA Displ
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The Case of the Son’s Adware

® Web page automatically opened on logon after father got
laptop back from son

® http.//www.e-markettop.com/

Top 10 Gainers, powered by Werden.com  TREMB 3890 4 +17.59% MA 33847 & +1339% -
Top 101 osers, powerad by Worden.com — SPW 61.23 134

® Tried running Malwarebytes, but it would immediately close
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http://www.e-markettop.com/

The Case of the Son’s Adware (Cont)

® Process Explorer showed one unsigned process, Crystal.exe:

". hidfind .exe 1068 Alps Pointing-device Driver
=1 L ipoint exe 1772 - |Poirt exe

zlp dpupdchic exe 4572  dpupdchk: .exe
= BT Tray exe 3504 Bluetooth Tray Application
_Jrundll32 exe 4696  Windows host process (Run... Microsoft Comporatio

® After suspending e R e B e
Crystal, Malwarebytes
ran to completion

‘ N O m a |Wa re re p O rted | Il:_:: '-:I:_Isers'-,JEFF'-,.-!-.ppE:lata'-F:-:-arnirng'-,l::r'g.-'::tal.e::-::e

Command line:

‘ M CAfe e d i d n ,t re p O rt Criusers\leff\appData'RoamingCrystal.exe”

Current directory:

any malware, either
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The Case of the Son’s Adware (Cont)

® Ran Autoruns and found Crystal in the Run key:

® Disabled it, rebooted and system operated normally:
problem solved

® Web search revealed that it was the Bifrost trojan:
http://comprolive.com/remove/trojan/bifrost/crystal-exe-usb-
exe-cleaner-exe
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The Case of the Scareware

® A user’s father-in-law complained that there was an

application that wouldn't exit:

B vwindows Perfomance Manager

General Settings

@ WANndows perfomance Manager

Wiruses: [ \Q dhiieacs
System errors: L Manager

Register errors:

Main Page

| 1
:‘, A IMDOM S sy stem 2\ mpnotify . exe

Scan complete
i = stem Security
A I 4 — Es n ::_".-.'--': general options of the
/A 1 \ - ' 29%

Scan in progress can complete
System Utilities

Esti 1 of the general productivity of
the m

30%

http:/ /www.microsoft.com /protect

Register

About Supporkt Help

- - Intel{R} Core{T™}2 Duo CPU ES400
intel?) % @ 3.00GHz

ft Windows XP

Copyright © 2011 Mark Russinovich



The Case of the Scareware (Cont)

® \When a user tries to run Task Manager or MsConfig, they
get errors, even in Safe Mode:

Warning!

Security alert
Enable protection

Deny

Enable Protection

Deny

Enable Protection
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The Case of the Scareware; Solved

® Ran Autoruns and one entry stood out as suspicious
® No company nhame or description
® Installed in user’s profile
® Replaces shell

® Right-clicked and “jumped” to the Shell registry entry
® Replaced malware name with “Explorer”
® Rebooted

® Problem solved
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The Case of the Unusable System

http://blogs.technet.com/b/markrussinovich/archive/2011/03/14/3412374.aspx
® Friend’s of a friend’s computer became infected with malware

® It was unable to run anythlng: Antivirus software alert 7

=nTIOH ALERT

iputer iz being attacked by an Internet

could be a password-ztealing attack, a

Spyware Alert !

dropper ar similar,

om: §6.180.54.25, port 12118
d port: 3906
BankerFosx.A

;:'g.:-_;tern- rmight be at

want block thiz attacky

AF computer
bl

e S IEi_tl_:l Ei:::'-.-'-.-'rnluzn:anzi daily

Stay unprotected

® Could have used Safemode, but wanted to see if I could run
something at logon before malware activated

® Logged off and back on
® Was able to run Process Explorer and Autoruns
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The Case of the Unusable System: Solved

® Process Explorer had one unsigned, random-name, packed
Imaggey

a
2220 RIM Auto Update Research In Motion Limited

-
£ RIMAutoUpdate exe
:1

wcescomm .exe Connection Manager Microsoft Corporation

MWenfied) Skype Technologees,,,

® Used Sigcheck to look for other suspicious files: none
@ Killed process, deleted autostarts: system clean i1 v russinovich



Deleting Autostarts

® Disable suspicious autostarts
® First rule of troubleshooting: make reversible changes

® After you're done do a full refresh

® If they come back, run Process Monitor to see who's
putting them back
® You might have misidentified a malware process
® It might be a hidden, system, or legitimate process
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Tracing Malware Activity
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Tracing Malware

® Tracing activity can reveal the system impact of malware
® Tracing shows initial infection, before cloaking is applied

@® Can reveal the internals of “buddy system” and other infection-protection
mechanisms

® Process Monitor makes tracing easy
® A simple filter can identify all system modifications

® Investigating stacks can distinguish legitimate activity from malicious activity
| = S

OO OOOO000AEY

Exp

T T

:Elq:nI-:an . f A X ) 4 O00-000
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Process Monitor

® Process Monitor is a real-time file, reqgistry, process and
thread monitor
® [t replaces Filemon and Regmon
® More advanced filtering
® Operation call stacks
® Boot-time logging
® Data mining views
® Process tree to see short-lived processes
® \When in doubt, run Process Monitor!
® [t will often show you the cause for error messages
@ It many times tells you what is causing sluggish performance
Copyright © 2011 Mark Russinovich




How Process Monitor Works

® Process Monitor uses a device driver
® Extracts the driver to \Windows\System32\Drivers

@® Installs the driver
@® Deletes the driver file

® Requires "Debug Programs” user right
® First run requires the “Load Driver” user right

Process Monitor Ul

User Mode

Kernel Mode
\

Registry Callback

%
[—
e
 rogeiyCaac

File System
Filter

TCP/IP Driver ETW

events

Kernel
Callouts s
opyright © 2011 Mark Russinovich



How Process Monitor Works (cont.)

® Registry monitoring:
® On Windows 2000, Windows XP 32-bit: system-call hooking
® On Windows XP 64-bit, Server 2003, and Vista: registry callback

® File system monitoring:
® File system mini-filter driver (causes Windows version requirements)

® Image loads:
® Memory-manager image load callback

® Process/Thread create/exit:
® Kernel process/thread callback

® TCP/IP
® ETW events emitted by TCPIP.sys
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Event Classes

File system (Filemon)
® Includes I/O command input and output detalls

Registry (Regmon)

® Includes all data (First 16-bytes part of REG_BINARY and first 2048-bytes for

other types)

Process

® Process create and exit

® Thread create and exit

® [mage loads, including drivers

Network

® ETW network tracing
Profiling

® Toolhelp thread snapshots
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Event Properties

® Event details

® Duration, process, thread,
details, etc.

® Process information
® Command line
® User
® Session and logon session
® Image information
@® Start time

® Thread stack at time of event
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Filtering

® To filter on a value, right-click on the line and select the
attribute from the Include, Exclude or Highlight submenus

® You can select multiple
values simultaneously
® When you set a highlight
filter you can move
through highlighted event
properties

ESEA)v,
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Demo: Watching a File Save

® Run Process Monitor, then:
® Run Notepad
® Type some text
@ Save the file as test.txt
® Find the real file save in the log file
® Set a highlight filter on the saved file path
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Symbols

® Download the latest Debugging Tools for Windows from
Microsoft (free)

® Configure Process Monitor's symbol engine:
® Use dbghelp.dll from the Debugging Tools
® Point at the Microsoft public symbol server

® To grab symbols for offline access, use Symchk, part of the
Debugging Tools

Configure Symbols

Process Monitor uses symbols to resolve function names when displaying thread stack
locations on the Stack page of an event's properties dialog.

If yvou do not reguire that infor on you do not need to configure symbaols.
DbgHelp.dll path {version 6.0 or later):
C:\Program Files\Debugging Tools for Windows\DbgHelp. dil

Symbols path:
srv*ct\symbals=http: ffmsdl. microsoft. comfdownloadsymbols|

| Ok
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Event Properties: Stack

@® The stack tab shows the stack of the thread executing the
operation

® Stack is function-call history
® Thread stacks can show root cause
® Uses symbol engine

E
‘

Function3 Stack Display
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Analyzing a Stack

® | ook at the function names and DLLs to identify the root
cause

® Double-click on a line to see the DLL properties

ftrmar.sys
fkmar.sys

Fi]'l'ar NMananor
B " Module Properties

\/ k odule: zpzmain. dll

= o =main. gl -
n = 165

PfpFileBuilldRead Support + (xed

PfpPrefetchFiles Trickle + eodf {81 595c Bcf

PfpPrefetchRequest Peform + 295 (81 595ecdf

PfpPrefetchRequest + (x16e <2195 1ch
Y et Superfetchinformation + k132 k315a513
e Zszzeneesd o ' stemInformation + DeS0e <8157 30d2

Company:

System Library ‘
superFefgfer-vtode

(root cause) .
System Library g

smain.dll ic - ] | ab T sysmain .dil
.malrn.n:lll ) asePrefetchPerfo L | % 3 wvsmain . dil
main .dll
smain.dll
: rsmain.-:"l 1= ]
kemel32 dl E':r:.-—-‘l'l’nr-—-:u:llnrt-l'l'lunl- + (o
ritdll .dll _RtlUserThread Stant + (23

)
u
u
u
u
L
U 2
U 2

Note: user stack capture isn't supported on 64-bit versicogyod W ddh MR/ Bessiao g0 3



Analyzing Process Startup with Stacks

® There are lots of file system I/Os and Registry operations
during Notepad’s startup

® Using the stack we can identify three phases:

® Prefetch
® Reads in directories
@ Faultsin DLLs

® DLL initialization
® |oader walks import tables
® Application initialization
® Initializes DLLs e.g. OLE
® Reads global settings
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Advanced Filters

® Multiple-filter behavior:
® Values from different attributes are AND'd
® Values for the same attribute are OR'd

® More complex filtering is available in the Filter dialog
® Outlook-style rule definition

® You can save and restore —
filters .

® Filter for watching
malware impact:
"Category is Write”

nm & mL
= =
3

JE0COCOCO 5

= = B s = My« I T
oo oo

esE EHE
d -
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The Process Tree

® Tools->Process Tree

® Shows all processes that have been
seen in the trace (including parents)

® Can toggle on and off terminated
processes

® The process tree provides an easy
way to see process relationships
® Short-lived processes
® Command lines
® User names
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The Case of the Slow Project File Opens

® Customer reported that opens of Project files from a
network were slow and 1 of 10 opens resulted in an error:

® Microsoft support asked them to captured a Process
Monitor trace
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The Case of the Slow Project File Opens (Cont

® First observation: tremendous number of access to share
because user-profiles stored there:

Tata | Ewents

Lppl at;
Lppl at
1.mpp
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The Case of the Slow Project File Opens (Cont)

® Second observation: Symantec
A/V prescans entire file:

B fModule Properties

Module: SRTSPES. Sy

Path: e tind o stemn32\Drivers\SRTSPEY . SYS
Description:  Swrantec AutoFrotect

Viersion: 10.3.0.14

COmpany': Syranktec Corparaktion

5 F.-au-:|F|I- WOBG.A0S. DB, O kYLD M
3 dFil=

dFile ) C - ' \ .mpp
dFile ML ) * ¥ - i
dFile . ik
dFil= ik LCOmSLOM I .

i .  CORMLOR -1 ! SAFOE LS ! \ ", jectl mpp

.mpp

.mpp
=1 15 _ i
] :‘j]'hl:l ueryDevicelnform... LSOk w] - = F c sject].mpp
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The Case of the Slow Project File Opens: Solved

® Recommendation 1: Move user profile AppData folders to
ocal system

® Recommendation 2: Disable local scanning of files on
network share since the server also has antivirus

® After recommendations followed, no more issues: problem
solved
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The Case of the Sysinternals-Blocking Malware

http://blogs.technet.com/b/markrussinovich/archive/2011/03/08/3392087.aspx

® Friend asked user to take a look at system suspected of being
infected with malware
® Boot and logons took a long time
® Microsoft Security Essentials (MSE) malware scan would never complete
® Nothing jumped out in Task Manager

® Tried running Sysinternals tools, but all exited immediately after
starting:
® Autoruns
® Process Monitor
® Process Explorer

@ Even Notepad opening a text file named “Process Explorer” would also
terminate
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The Case of the Sysinternals-Blocking Malware
(Cont)

® Looking through Sysinternals suite, noticed Desktops utility

® Hoped malware might not be smart enough to monitor
additional desktops

® Sure enough, was able to launch Process Monitor and other

tools:

® Malware probably
looks for tools in
window titles

® Window enumeration
only returns windows
of current desktop

Igvjﬂ 12:55 AM

Copyright © 2011 Mark Russinovich
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The Case of the Sysinternals-Blocking Malware
(Cont)

® Nothing suspicious in Process Explorer

® Next, ran Process Monitor
® Noticed a lot of Winlogon activity, so set a filter to include it
. Could see a once-per- second check of a strange key:

HKLMKSoﬁwarE\Mm:'nscﬁ\Wndm NT\EurrE:ﬂVﬂson\Wnlogon\Nc‘hﬁr\acdcacaeaacbaﬁ&eaa

&

L

[t

[t

1P
T

i

d:

® Saw name of random DLL In thekey

=) _l.__: |r|||_:|:|| on . |_.T_'L.,"\] As I.n.:hr: Nous
|____‘| Credentials Ejf'"”-:ln""
+-[_] GPExtensions 8] Impersonate

= |__—| Motify

. aly OCE
Y- cicacacanchatbeaa Shode
E .I w3 2chai . Legeff
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The Case of the Sysinternals-Blocking Malware:

Solved
® Tried deleting the key, but after refreshing it was back

® Went back to MSE and directed it to scan just the random
DLL image file on disk:

- Microsoft Security Essentials Alert

nputer stat

x—' Potential threat details ]‘

® After clean, was able to delete Registry key and system was

back to normal: problem solved
Copyright © 2011 Mark Russinovich



The Case of the Malicious Autostart

http://blogs.technet.com/b/markrussinovich/archive/2011/02/27/3390475.aspx

® Microsoft Support got a report of Marioforever.exe
malware spreading within a company

® Malware infected Winlogon:

r-,Al__-_IAIm,lI-_tJ_t\IAII-A :-I- ‘..IA:IA ~y somde A v AT~ lﬁlnnn:mﬂ
C:\>11std11s winlogon -d nvrsma.dl]

ListDLLsS wv2.25 — DLL Tlister for Win9x/NT
Copyright (C) 1997-2004 Mark Russinowvich
Sysinternals - www.sysinternals.com

winlogon.exe pid: 416
Command Tine: winlogon.exe

Base Size version Path
O0x10000000 0Ox34000 C:\WINDOWS\system32\nvrsma.dl]

® The malware didn’t show up in Autoruns, so how it loaded

was a mystery
Copyright © 2011 Mark Russinovich
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The Case of the Malicious Autostart (Cont)

® Captured a Process Monitor boot log and searched for
nvrsma:

ﬂ I| winl l; £| |;| n

Vmmire = S
Type: REG_S5Z, Length: 14, Data: nvrsma
Desired Access: Cuerny Value

oS
ESS

SUCCESS Jesired Acc
MAME MOT FOUMD Length: 16

® Reference is in "bwplnit_DLLs" key
® That's not a Windows autostart key
® Similar to Applnit_DLLs, a legitimate key

® Why was Winlogon loading DLLs referenced there?
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The Case of the Malicious Autostart (Cont)

® [aunched Autoruns again on infected system and
User32.dll stood out:

ornponent. ..

@® Autorunsc confirmed that they were different:

user3z2.dll
windows XP USER API Client DLL

(Not wverified) Microsoft Corporation
5.1.2600.5512

c:\windows\system32h\user3z.dl1

5088c5a9fac8lldcbcbd&3924ae824fa (MD5)

1be263d5ca3b4ea0lf0378d1177aa9cc27459b98 (sSHA-1)

b820443071859c2d6a0f53b011dd3ffaazd7ad48f7a930c08dc55096ddfezaedb (SHA-256)
user32.dl11

wWindows XP USER API Client DLL

(Verified) Microsoft windows Component Publisher
5.1.2600.5512

c:windows\system32huser3z2.dl1
b2zebl35ff1lb9f60c9388b4a7dletTe00b (MD5S)
DSEEQFf%ngESde3?adedb10d65fb044?b91£eSF(SHg—l) £ ¢ 5 . .
acdOae7bddsf871leld8276cbeccdaedazlee33Te7Tc/78d827cl16986el1T945438cC SHA-256
6e1f945438c (SHA-256) lark Russinovich



The Case of the Malicious Autostart Solved

® Looked at DLL properties in Process Explorer
® In-memory strings were the same
® On-disk strings had one difference:

.
B USER32.dll Propertie

mage 2ktrings

Printable strings found in th

® Rebooted system into Microsoft Diagnostic and Repair
Toolkit and replaced User32.dll with good version: Malware

Cleaned Copyright © 2011 Mark Russinovich



Basic vs Advanced Mode

@® Basic mode includes filters that exclude system activity
® Process Monitor activity
® Paging file
® System process
® NTFS metadata files

® Basic mode massages I/O names:
® E.g. IRP_MJ_READ => ReadFile

Copyright © 2011 Mark Russinovich



Logging to a File

® By default, logging is page-file backed
® Use Options->History Depth to avoid memory exhaustion
® Or use Filter->Drop Filtered Events

@® Use the File->Backing File dialog to specify logging to a file

® Data is written In NatiVe e
as Its captured — |

® Log size is limited
only by available
disk space

® Dialog also shows
trace statistics

Copyright © 2011 Mark Russinovich



Running Process Monitor Before Logon

® Sometimes need to capture I/O or registry activity during
boot, the logon or logoff process

® Problem: when you logoftf all your processes
are terminated

@® Solutions: Run Process Monitor in a different logon session
® psexec —s—i—d

Copyright © 2011 Mark Russinovich



Boot Logging

® Process Monitor can capture all activity from very early in
the boot process:

® Options->Enable Boot Logging

® Capture continues through shutdown or you run Process
Monitor
® |og data is saved as raw data to %Windir%\Procmon.pmb

® The next time you run Process Monitor it will offer to transform
the data to a native PML log

® Enable Advanced Output to see all events

@ Typical Windows Vista boot->Log in->Shutdown generates

1'2 mllllon events Copyright © 2011 Mark Russinovich



Stuxnet and Alureon
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Analyzing a Stuxnet Infection

http://blogs.technet.com/b/markrussinovich/a rch|ve/2011/03/30/3416253 aspx

Discovered June 2010 after it had
spread for year

Exploited 4 zero day Windows
vulnerabilities

® Print spooler for remote code execution
® Shell link Explorer code execution from

i ﬂfe Cted key www President ir '
: : 1 7t Iranian President Mahmoud Ahmadinejad observes computer monitors at the
. WI nZK/WI ndOWS XP W|n32k5y5 p”V' |ege Natanz uranium er:richment plantin central Iran, where Stuxnet was believed to

have infected PCs and damaged centrifuges. (Photo: Office of the Presidency

e l evatl O n of the Islamic Republic of iran)
® Windows 7 Task Scheduler privilege elevation

Drivers signed by certificates stolen from RealTek and JMicron
Rootkit code for Siemens Step 7 SCADA PLC for centrifuges

Suspected to have targeted Iranian centrifuges used for Uranium enrichment at
Natanz nuclear facility
® Iran confirms in September 2010 that thousands were destroyed

® Suspected to be created by Israel and US Copyright © 2011 Mark Russinovich



http://blogs.technet.com/b/markrussinovich/archive/2011/03/30/3416253.aspx

Analyzing an Alureon Infection

® First malware to bypass 64-bit Windows Kernel-mode Code
Integrity
® Modifies MBR and boots system in “WIinPE" mode — code
Integrity is off

® |Loads malicious unsigned Kdcom.dll from hidden sectors off end
of volume

® Modifies registry boot flags to hide WinPE mode so system
continues to boot normally

® Uses modified disk driver to mask modified MBR
® Took A/V several months to develop on-line cleaning

® \ery little visible sign of infection
Copyright © 2011 Mark Russinovich



Summary and the Future



The Future of Malware

We've seen the trends:

® Malware that pretends to be from Microsoft or other legitimate companies
® Malware protected by sophisticated rootkits

® Malware that has stolen certificates

Cleaning is going to get much, much harder

Targeted and polymorphic malware won't get AV/AS signatures

Malware can directly manipulate Windows structures to cause misdirection
All standard tools will be directly attacked by malware

There will be more un-cleanable malware

Malware will adapt to a limited-user environment

You can’t know you're infected unless you find a symptom

The bottom line is that prevention and containment is the best
defense
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Zero Day — A Novel

® A cyberthriller true to the science
® www.zerodaythebook.com
® Signing from 3-3:30 at the bookstore

"""""

http://www.youtube.com/watch?v=ucyMBYg9RWU Copynght © 2011 M Rus Tovich



http://www.zerodaythebook.com/
http://www.youtube.com/watch?v=ucyMBYg9RWU

The Sysinternals Administrator’s Reference
® The official guide to the Sysinternals tools

® Covers every tool, every feature, with tips _—
® Written by markruss and aaronmar Windows g
® Available in June Sysinterna-"

@ Full chapters on the major tools: Administrator’

® Process Explorer Reference

® Process Monitor

® Autoruns
® Other chapters by tool group e G
® Security, process, AD, desktop, ... B v Varso,

http://technet.microsoft.com/en-us/sysinternals/hh290819
Copyright © 2011 Mark Russinovich



http://technet.microsoft.com/en-us/sysinternals/hh290819
http://technet.microsoft.com/en-us/sysinternals/hh290819
http://technet.microsoft.com/en-us/sysinternals/hh290819
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